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USER GUIDE

SCC-A10 Voltage Attenuator Module

The SCC-A10 voltage attenuator module accepts up to two voltage sources
of 60 V maximum amplitude and attenuates each voltage by a factor of 10.
A differential instrumentation amplifier buffers each input signal. The
SCC-A10 contains circuitry capable of protecting E/M Series DAQ
devices for input signals up to 60 VDC.

Conventions

The following conventions are used in this guide:

<> Angle brackets that contain numbers separated by an ellipsis represent
a range of values associated with a bit or signal name—for example,
AO <3..0>.
» The » symbol leads you through nested menu items and dialog box options

to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

> @

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on
the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

ﬁ When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

é When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select in software, such as menu
items and dialog box options. Bold text also denotes parameter names.
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italic

monospace

SC-2345

SCC

Ttalic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and the SC-2345
configurable connector.

SCC refers to any SCC Series signal conditioning module.

What You Need to Get Started

To set up and use the SCC-A10, you need the following items:

U Hardware
- SCC-68
or
—  SC-2345/2350 with one of the following:
« SCC-PWRO1
¢ SCC-PWRO02 and the PSO1 power supply

e SCC-PWRO03 (requires a 7 to 42 VDC power supply, not
included)

—  One or more SCC-A10

—  68-pin E/M Series DAQ device
—  68-pin cable

—  Quick Reference Label

U Software
—  The latest version of NI-DAQmx

U Documentation
—  SCC-AI0 Voltage Attenuator Module User Guide
—  SCC-68 User Guide
or
- SC-2345/2350 User Manual
—  SCC Quick Start Guide
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—  Read Me First: Safety and Radio-Frequency Interference
—  Documentation for your hardware

—  Documentation for your software

QO Tools
— 1/8 in. flathead screwdriver
— Numbers 1 and 2 Phillips screwdrivers

—  Wire insulation stripper

@ Note Software scaling of measurements is not supported on the Macintosh operating
system. Refer to the SCC-A10 Module Pin Assignments section.

You can download NI documents from ni . com/manuals. To download
the latest version of NI-DAQmzx, click Download Software at ni . com.

Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2345/2350 and SC-68, refer to the SCC Quick Start Guide,
available for download at ni . com/manuals.

Installing the Module

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

You can plug the SCC-A10 into any analog input socket on the
SC-2345/2350 or SCC-68. The socket you choose determines which E/M
Series DAQ device channels receive the SCC-A10 signals, as explained in
the SCC Quick Start Guide.

For single-stage input conditioning, plug the SCC-A10 into any slot of the
SC-68, or any socket of the SC-2345/2350 J(XH), where X is O to 7.
Connect the input-signal wires to the module as described in the SCC Quick
Start Guide.

If you use the SCC-A10 in a dual-stage configuration in an SC-2345, the
SCC-A10 must be the first-stage module. Plug it into any socket J(X-0) and
plug the second-stage SCC into socket J(XH), where X is O to 7. Connect
the input-signal wires to the SCC-A10 as described in the SCC Quick Start
Guide. The SC-2345 connects the output signals of the SCC-A10 to the
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inputs of the second-stage SCC. An example of dual-stage conditioning is
an SCC-A10 followed by a lowpass filter module (SCC-LPXX).

Sockets J9 to J16 of the SC-2345 are also available for digital input/output
(DIO) conditioning or control. Refer to the SC-2345/2350 User Manual for
more information about configuring, connecting, and installing SCC
modules.

Connecting the Input Signals

@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg to
confirm the signal names.

Each screw terminal is labeled by pin number <1..4>. Pins 1 and 2 form

a differential channel routed to E/M Series DAQ device channel X-8, and
pins 3 and 4 form a second differential channel routed to E/M Series DAQ
device channel X. The value of X is determined by the number of the
SC-2345/2350 socket where you plug in the module, J(X4) or J(XO) or the
slot number on the SCC-68.

The signal source can be floating or ground-referenced. Floating signal
sources do not require bias resistors to ground with the SCC-A10. Figure 1
shows the SCC-A10 signal connections.

Signal SCC-A10 . E/M Series DAQ Device
Source 4., Overvoltage | i ;
Protection H !
i o :
C_ :I>—>: LAL(X) :
Overvoltage | | o ;
v : Protection i !
! '+ Al SENSE !
2~ Overvoltage | i+ AlGND ;
Protection " ,
" ¥ :
C_ :I>—>: LAI(X+8)
Overvoltage | |
R : Protection P :

.~~7-> Signal source may be floating or ground-referenced.

Figure 1. SCC-A10 Signal Connections
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For information about how to configure the SCC-A10 module using
NI-DAQmzx, refer to the SCC Quick Start Guide.

Using the SCC-A10 when Scaling Voltage Measurements

If you configured the SCC-A10 using Measurement & Automation
Explorer (MAX) and you are using NI-DAQ, the voltage reading you get
from the E/M Series DAQ device accounts for the voltage scaling effect of
the SCC-A10. Otherwise, because the voltage measurement from the
E/M Series DAQ device is one-tenth of the voltage applied at the SCC-A10
input, you must multiply the voltage reading from the E/M Series DAQ
device by 10 to get the correct SCC-A10 input voltage.

Specifications

@ Note In order for the SCC-A10 to perform according to the specifications in this guide,
the 15 V power supply you use must be accurate to within 5%.

These ratings are typical at 25 °C unless otherwise stated.

Analog Input

Number of input channels
Input range
Input impedance

Gain error

..................................... 1 MQ (powered on or off)

.......................................... 10.14% of reading max!

Gain-error temperature coefficient........ 10.006% of reading/°C max

Offset error

........................................ 16.5 mV max (referred to

input [RTI]?)

Offset-error temperature coefficient...... 80 uV/°C max (RTI)

Nonlinearity

Common-mode rejection ratio

I' Temperature range is 23 °C +5 °C.

2 Calculated with respect to the input range

© National Instruments Corporation

....................................... 40.004% of full scale

............... 60 dB min (DC to 60 Hz)
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Dynamic Response

Bandwidth (-3 dB) .....cccoevveiiiiiinn 10 kHz
Output settling time to within

0.01% of nominal input voltage ............. 15 us

Output SIEW rate.......ccceveereerereerieneeienne 0.75 V/us min

Power Requirement

ANalog POWET ..vveveveeiieieeieeieeeieeieene 100 mW max
SV o 3.2 mA max
ISV 3.2 mA max
Digital power (5 V)....coceecvevivcininiiennne 0.0 mA
Physical
1.87 cm
, (0.74in) | 7.93 cm .
< > < (3.121n.) >
3.55cm
(1.41in.)
Figure 2. SCC-A10 Dimensions
Weight ..o 29 g (1.0 0z)
I/0 conNectors.........coeueeeereeneenienieeienienne One 20-pin right-angle
male connector,
one 4-pin screw terminal
Wire gauge range........cccceeeeeeneneeniennenns 24t0 12 AWG
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Maximum Working Voltage
(Signal + common-mode) each input should remain within 60 VDC of
ground.

Maximum working voltage refers to the signal voltage plus the CMV.

Channel-to-earth (inputs) ..........cccceeueeee. 60 VDC,
Measurement Category I

Channel-to-channel (inputs)................... 60 VDC,
Measurement Category I

A Caution This device is rated for Measurement Category I and is intended to carry signal
voltages no greater than 42.4 V., or 60 VDC. Do not use this device for connection to
signals or for measurements within Categories II, I1I, or I'V.

Environmental
Operating temperature............coceerveenenn 0to50°C
Storage temperature ............cccoeeeeeuenneee —20to 70 °C
Humidity ..oooeveeniiniiiiniiiiciecs 10 to 90% RH, noncondensing
Maximum altitude ............coovvvveviinnnnnnnns 2,000 m
Pollution Degree (indoor use only)........ 2

Safety

The SCC-A10 is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« JEC61010-1, EN 61010-1
« UL 61010-1
*+ CAN/CSA-C22.2 No. 61010-1

@ Note For UL and other safety certifications, refer to the product label, or visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.
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Electromagnetic Compatibility

EmiSSiONS....cccvvveiieiiieiieeeeiieeeeeeeiveeeeeenns EN 55011 Class A at 10 m
FCC Part 15A above 1 GHz

IMmMUNity ...ooooeeveeeeeieeee e EN 61326:1997 + A2:2001,
Table 1

EMC/EMI ......oooovieiiiiieiieeeeee e CE, C-Tick, and FCC Part 15
(Class A) Compliant

@ Note For EMC compliance, operate this device with shielded cabling.

CE Compliance

The SCC-A10 meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety).............. 73/23/EEC

Electromagnetic Compatibility
Directive (EMC).....ccoceoveviniiiininicene 89/336/EEC

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.
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SCC-A10 Module Pin Assignments

Figure 3 shows the I/O connector pins on the bottom of the module.

1 Pin1 2 Pin2

3 Pin19 4 Pin 20 |

Figure 3. SCC Module Bottom View

Table 1 lists the signal corresponding to each pin. Al (X) and Al (X-8) are
the analog input signal channels of the E/M Series DAQ device. Al GND is
the analog input ground signal and is the reference for Al (X) and Al (X-8).
A GND is the reference for the £15 V power supply. AI GND and A GND
connect to the SC-2345/2350 at the SCC-PWR connector.

Table 1. SCC-A10 Module Pin Assignments

Pin Number Signal
1 E/M Series Al (X)
2 E/M Series AI GND [AI (X) REF]
3 —
4 E/M Series Al (X8)
3 —
6 E/M Series AT GND
7 —
8 E/M Series AI GND [AI (X48) REF]
9 —
10 —

© National Instruments Corporation 9

SCC-A10 Voltage Attenuator Module User Guide



Table 1. SCC-A10 Module Pin Assignments (Continued)

Pin Number

Signal

11

A GND

12

13

H5V

14

-15V

15

16

17

18

19

20

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.
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